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Overview 

GOCAD® Mining Suite 14.1 is a customized extension of SKUA-GOCAD™ – Paradigm® 14.1.  The 

interface has gone through significant changes, focusing on improved data organization and analysis. 

Enhancements include automatic classification of data on import into geological categories. A new tab 

layout allows users to view, investigate data and store results, ensuring a more auditable process. It also 

has a powerful new macro programming environment. 

 

The main themes in this release include: 

 

• Improving usability: 

o Revisiting object management to provide a more geological and task-oriented browsing 

approach and to eliminate the need for systematic unique object names. 

o Revisiting the layout to introduce the notion of tabs that are similar to those introduced in 

Web browsers. The new tabs provide task-oriented layouts with specialized tool sets for 

given tasks. 

o Modifying graphic style control to enable the use of templates for displaying objects across 

multiple views. 

o Introducing the notion of scenarios and results. Scenarios enable the creation of many 

objects in different “what-if” scenarios without naming conflicts and the tracking of decision 

points, nested tasks, and alternative strategies. Results are stored in tables, providing a 

database-like interface and enabling complete analytical functionality to understand 

relationships between results and input parameters. 

 
• Merging SKUA and GOCAD into a single application. All SKUA and GOCAD workflows are 

accessed in one shared workspace. Existing SKUA and GOCAD projects opened in SKUA-

GOCAD will not lose any of their objects or workflows. 

 

• Redesigning GOCAD Mining Suite add-on modules and workflows so that all import 

functionalities take into account mining specific themes. They now take advantage of how data 

can be grouped, filtered, and sorted in the data browsers. The core functionality remains the 

same as in our previous 2009.4p1 release.  
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New features and enhancements 

User interface 

The user interface contains several new features and enhancements. The following is a non-exhaustive 

list of the changes. 

 

Tabs ................................................................................................................................................. 7 

Data access...................................................................................................................................... 8 

Shortcuts .......................................................................................................................................... 9 

3D Viewer/Camera ......................................................................................................................... 10 

Workflows ....................................................................................................................................... 12 

Scenarios ....................................................................................................................................... 12 

Tables ............................................................................................................................................ 13 

Results ........................................................................................................................................... 13 

Macros ........................................................................................................................................... 14 

Images browser .............................................................................................................................. 15 

Notes browser ................................................................................................................................ 16 

Stereonet application ...................................................................................................................... 17 

 

Tabs 
A tab regroups tools to easily achieve a given task. You can create as many tabs as you need. The built-

in tabs are: 

• Viewer tab. Contains the default 3D Viewer. GOCAD Mining Suite modules that used the Task 

Pane in v2009.4p1 now operate under this tab. 

• Data tab. Contains tables for given data types (wells, horizons, markers, and other data types). It 

focuses on geological modelling. 

• Workflows tab. Contains the workflow and scenario manager and/or an instance of a workflow 

and its associated views. 

• Results tab. Contains tables of numerical results (volumes, map areas), snapshots, and reports. 
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The following are examples of the built-in tabs: 

Browse through your data from the Viewer tab. 
The Viewer tab contains the 3D Viewer and the 

associated display elements and toolbars. 

 

Work through tasks in workflows from the 
Workflows tab by using the workflow task panel 

and the workflow browsers. 

 
Analyze your data from the Data tab by 

displaying tables and one or more views. 

 

 

Analyze your results from the Results tab by 

comparing outputs, such as tables, plots, or 

pictures from different scenarios. 

 
 

Data access 
• Display Elements. The Display Elements area is associated with the active view. This area 

contains several browsers listing the "elements" you can display in the active view, that is, objects 

properties and resources. 

 

You can dynamically group, filter, and sort the data in these browsers. For example, you can sort 

the Objects browser by modelling categories, data type, feature type, object type (the default view 

in earlier versions from the Object Tree), date, user, scenario, or other sorting criteria. When data 

is imported, the import filters will prompt you to classify your data so you can take advantage of 

this powerful new interface. 
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Another new browser, the Properties browser, is very useful for quickly displaying a property on 

all the objects containing the property. 

 

Objects sorted by feature types (wells, 
horizons, faults, geoscientific data, and so on) 

 

Objects sorted by object types 
 

 
 

• Lists. Functionality related to Groups and Favorites has been consolidated into Lists. Like 

Favorites, Lists can be selected in data selectors and can contain data of different kinds or the 

same kind. 

• Selectors. In data selectors, you can now filter the list of objects available for selection and you 

can control the type of data shown in the selector. For instance, you can quickly select all the 

objects whose name contains a given string or keep only the data belonging to a given domain. 

Shortcuts 
One goal of this version is to reduce mouse clicks and mouse movements. To this end, we: 

• Added mini toolbars to the shortcut menus and added a coordinate area that displays the current 

pointer location along with the property value, eliminating the need to click a point. 



 
P a g e  | 10 

 

© 2015 Mira Geoscience Limited. All rights reserved 

• Added more options to the shortcut menus. 

• Each browser in Display Elements has a Create button so that you can quickly create objects. 

 

Create Objects from browsers 

 
Mini toolbar 
Similar to Microsoft Word, to eliminate many 

mouse movements, a "mini" attribute toolbar is 

available when you right-click any object in an 

object browser or the active view. 

 

Coordinates area 
As you move the pointer over an object, the 

coordinates, object name, and displayed property 

values appear in this area. 

 

 

 

3D Viewer/Camera 
In addition to the direct 3D coordinates and information area, the 3D Viewer has a series of new and 

enhanced features: 

• Mouse movements. You can now use the mouse scroll wheel to zoom the view. You can access 

shortcut menus by right-clicking in the 3D Viewer. 

• Keyboard shortcuts. The keys F1-F6 and F8 now correspond to orthogonal views (top, bottom, 

N, S, E, W). For more information, see SKUA-GOCADTM - Paradigm® 14.1 User Guide, Part I: 

Getting Started, Appendix B, Keyboard and Mouse Commands, accessed from the Paradigm 

folder in the start menu. 
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• Color map. Now, you can move and resize the color map, and you can display it in a horizontal 

or vertical layout depending on its aspect ratio. When the property displayed is a discrete 

property, the color map transforms into a legend with labels for the discrete values. 

• Scale bar. You can show the current scale in the 3D Viewer by displaying the new scale bar. 

• Lighting. You can control the lighting in the 3D Viewer by moving the new light bulb tool around 

in the view. 

• Highlighting and editing. By double-clicking an object, the object becomes highlighted in the 3D 

Viewer and the Objects browser, and the editing toolbar for the object appears near the top of the 

window. 

• Multiple linked views. Multiple views can be tiled and linked to synchronise the 3D Viewer 

movements while displaying different objects and properties. 

• Style templates. Now you can use templates to control the style settings (appearance) of 

objects. By assigning templates to objects, you can easily control the common styles of many 

objects in one step. You can also assign a template to an object for each view you have open or 

assign a single template to an object, so that you can control the appearance of the object 

separately in each view or in all views at once. 

 
Grid displayed in two linked views with different templates. 
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Workflows 
• Easy Access to Data. For instance, in the Structure and Stratigraphy Workflow, you can open 

the stratigraphic column at any moment and visualize all or some of the wells used in the 

workflow along with models and data. 

• Improved navigation within workflows. To decrease the number of clicks required, a Go to 
button has been added to the workflow panel, which allows you to quickly jump between panels 

without having to click through intermediate panels. 

• Linked studies. Some workflows are now linked, such as the Interpretation Modeling and the 

Structure and Stratigraphy workflows. Linked studies have similar colors and a link icon. 

 

Scenarios 
This version includes a new set of tools to perform multiple-scenario modelling and analysis. You can 

create "what-if" scenarios and work through workflows in each scenario. Scenarios contain objects, 

properties, and results that you create. Scenarios are also key identifiers for objects, such that objects 

with the same name but created in different scenarios are considered as separate objects without any 

naming conflict. 

In the Scenarios browser (on the Workflows tab), you can create workflows at any point within the 

scenario hierarchy. 

 

 
Objects and workflows created in scenarios, reflecting 

different hypotheses in the interpretation and modeling. 
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Tables 
Objects, such as horizon models, fault models, wells, markers, and other objects, can be listed in tables 

along with their associated attributes (for example, horizon area, dip, fault displacement, and well API or 

TVD). 

Like in Microsoft Excel, you can apply filters at the top of each column, and you can plot numerical results 

and numerical object attributes in histograms or crossplots for analysis. The figure below shows a 

crossplot between the vertical fault extension and the fault displacement for over 100 faults in the current 

scenario. Faults highlighted in the plot are also highlighted in the 3D Viewer and vice versa. 

 

 
Tables and plots. 

 

Results 
This version introduces the notion of numerical results from workflows. Results are recorded in a results 

table with all the associated input parameters. You can then easily create crossplots of the results and 

input parameters. Other types of results include images, notes, and reports created from workflows. 
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Macros 
You can now interactively create your own macros from a series of recorded commands or commands 

retrieved from the session or object history. You can tag command parameters as variables and then run 

your macro using different values for the variables. You can also run macros from the new Macro Player 

Workflow, which prompts you to provide a range of potential values for each variable and then run the 

resulting scenarios. You can view and analyze the macro results in the Analytics browser (on the Results 

tab). 

 

 
Results table and analysis history, histogram, and Crossplot.  
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Images browser 
An Image browser is available (on the Results tab) that contains any snapshot you take in the project. 

With the new snapshot tool (available on the mini toolbar), you can automatically take a series of 

snapshots. For example, you can take snapshots of all the sections of a grid showing the same property. 

Displaying images that show different properties on the same grid side-by-side enables you to quickly and 

easily screen the model. 

 
Images browser showing grid sections with facies probability (left) and facies model (right). 
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Notes browser 
A Notes browser is available on the Results tab, where you can add comments to the current 

conversation on a particular topic and access those comments. You can add notes to objects, workflows, 

scenarios, and views. 

 

 
Notes browser showing comments, snapshots, and discussions for some objects. 
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Stereonet application 
A new Stereonet application is introduced to display dip and azimuth data. Accessed from the Application 

toolbar , the application includes three plotting areas: the stereonet diagram 

where data is plotted as poles or planes in a Schmidt, Wulff or Polar projection, and two rose diagrams to 

respectively display the dip and azimuth as circular histograms. 

 

You can interactively select data in the stereonet by using multiple selection tools including predefined 

shape selection and freehand selection to create different families. 
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GOCAD Mining Suite add-on modules and workflows 

The following is a list of changes and how they affect our modules and workflows from the previous 

2009.4p1 release. 

 

Project Module Selector .................................................................................................................. 18 

Mining Utilities ................................................................................................................................ 19 

3D-GIS ........................................................................................................................................... 20 

Potential Fields Module and Workflow............................................................................................. 20 

Electromagnetic Module ................................................................................................................. 21 

Sparse Module ............................................................................................................................... 22 

ioGAS Link ..................................................................................................................................... 22 

Geotech Module and Geohazmap Workflow ................................................................................... 22 

Targeting Workflow ......................................................................................................................... 22 

Seismic Module .............................................................................................................................. 22 

 

Project Module Selector 
Mining modules are found in the last tab of the selector. You can access them by pressing the right arrow 

at the tabs level or by resizing the window. 

Certain modules underwent minor name changes. The Seismic Interpretation and Volume Explorer 

modules are now grouped under the Interpretation Modeling module and can now be found in the Basic 

Earth Modeling tab. 
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Mining Utilities 
The mining importers are now arranged by the type of data being imported. They prompt classification of 

data sets by modelling category via a drop-down menu. When desired, these categories can be classified 

by data type. You can also define a Feature to group data, e.g., point data and its gridded representation 

can be placed in the same Feature to indicate that they are related. 

 

Mining Importers 

 

Classification and Feature Selector 

 

Note: The full list of mining-related categories and classifications is available here. 

 

• All core Mining Utilities functionality, including a selection of wizards, remain the same as 

2009.4p1. 

• The Mira Geoscience Stereonet has been deprecated in favour of the new Stereonet application. 

• The Interpretation and Structural Workflow have been reduced in scope to Volume of Interest 

Surface and Volume of Interest Grid object creation. 

 

Not included in this release, but will be reintroduced in an upcoming release: 

• Geosoft binary GRD and GDB importers. 

• acQuire drillhole database importer. 

• OLEDB drillhole database importer. 

• 2D-section. 
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3D-GIS 
The 3D-GIS query interface can now be accessed from 3D-GIS button in the Mira Taskpanes Toolbar. 

Functionalities remain the same. 

 
 

Potential Fields Module and Workflow 
The module supports UBC-GIF GRAV3D v3.0 and MAG3D v4.0, and Fullagar Geophysics VPmg v7.1. All 

menu bar functionalities remain the same while taking advantage of object classification. 

 

For easier navigation, the UBC-GIF and VPmg menus have been redesigned: 

UBC-GIF menu 

 

VPmg menu 
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The Potential Fields Workflow UBC-GIF has been ported to v14.1 whereas the Fullagar Geophysics 

VPmg workflow was not ported in this release. The UBC-GIF workflow is accessed from the Workflows 

tab and now uses its own 3D viewer and object display tree. 

 

 
 

Electromagnetic Module 
It supports UBC-GIF DCIP2D v3.2 and DCIP3D v2.1, and Fullagar Geophysics VPem1D v2.1. All menu 

bar functionality remains the same while taking advantage of object classification.  

Radio Imaging Method (RIM) tomography functionalities are not supported in this release, but will be 

reintroduced in an upcoming release. 

The Loop Designer interface can now be accessed from Loop Designer button in the Mira Taskpanes 

Toolbar. 
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Sparse Module 
Sparse functionality remains the same while taking advantage of object classification. The Sparse 

modelling interface can now be accessed from Sparse button in the Mira Taskpanes Toolbar. 

 

 
Plunge modelling has been temporarily removed from the Structural Field Interpolator (SFI) as we are 

working on a more accurate solution. 
 

ioGAS Link 
The live link with ioGAS (up to v5.2) remains the same while taking advantage of object classification. 
 

Geotech Module and Geohazmap Workflow 
Functionalities remain the same while taking advantage of object classification. 
 

Targeting Workflow 
Functionalities remain the same while taking advantage of object classification. 
 

Seismic Module 
This module is not supported in this release, but will be reintroduced in an upcoming release. 
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Starting a new project 

This section assumes that you are familiar with GMS 2009.4p1 and that you have read the Release notes 

that explain the new functionality in GOCAD Mining Suite 14.1. It is designed to help you start a new 

project in 14.1 and import your data.  

Starting a new project… is the same as in previous versions 

You can start a New Project and select your modules. As with all new projects, be sure to set your 

preferred default settings in Edit > Preferences. 

All menu-driven commands are as they were in 2009.4p1 and apart from the interface changes outlined in 

the Release notes, the principal change for starting a new project is how data is imported. 

The import filters are in the same location as before (File > Import). They are now arranged by the type 

of data you are importing. 
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Once an importer is opened, it prompts the user to further define the data type by classifying it and 

creating a feature. 

 

Classifications define the role of your modelling objects while features are a way to group modelling 

objects that are related to one another. 

Modelling categories and classification 
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General instructions for working with classifications 

Mining importers and dialogue boxes that create new objects provide a filtered list of classification options 
depending on which data category they are accessed from. 
 

 
Classifications can be selected from a drop-down, or cycled 
through by typing the first letters of the desired classification. 
 
Feature names can be used to group objects that belong 
together, e.g., the markers, curves, points and surfaces for a 
particular horizon or geophysical survey data and the gridded 
version of the data. 
 

Objects can be reclassified by dragging to existing features or right-clicking and selecting “Assign to 
Geologic Feature”. 
 
Print version of the classification table is available here. 
 
Some examples of how features can be used 

• Assigning multiple modelling objects to a single feature ties them together. Horizon feature should 

contain the markers, points, curves, surfaces, etc. that pertain to a particular geological contact. 

• A feature can be used to group data points/lines and grids from a particular geophysical survey 

within the appropriate Classification, e.g. Airborne Magnetics. 

If the Feature Name box is left empty, the default will be the name of the object after it is imported. 

Once the data is imported, if Classifications and Features need to be reassigned, they can be via the 

methods outlined in Opening a 2009.4p1 project in 14.1.  

Other useful resources can be found in the SKUA-GOCAD 14.1 help docs accessed from the Contents 

and Index 

  

 

 

 

 

http://www.mirageoscience.com/data/media/all/original/classification.pdf
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Opening a 2009.4p1 project in 14.1 

This section assumes that you are familiar with GMS 2009.4p1 and that you have read the Release notes 

and Starting a new project section that explain the new functionality in GOCAD Mining Suite 14.1. It is 

designed to help you convert a 2009.4p1 project into a 14.1 project.  

From 2009.4p1 to 14.1 

A typical 2009.4p1 project might contain the following model components (data or objects): 

• Drillholes imported from a database or planned targeting. 
• Geophysical data and models such as stations, flight lines, grids and inversion models. 
• DTMs. 
• Geological interpretations and surfaces/wireframes. 
• Topographic information such as roads, rivers, etc. 
• Block models. 
• Desurveyed data. 
• Etc. 

And the Objects display looks similar to this: 
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Objects were grouped by “type” such as PointsSet, Curve, Surface, Voxet, etc. The user had to 

remember that objects representing one component of their model may have been represented by 

several types of GOCAD Objects. 

In 14.1, much of the menu functionality remains the same, but the way in which your model components 

(data and objects) are listed is a little different. By default, they are now organized by geological 

classification (e.g., topographic information, geophysical survey type, etc.) and sorted by objects that 

represent the same geologic feature.  

When a 2009.4p1 project is opened in 14.1 for the first time, GOCAD will reorganize your objects but 

some sorting will be needed on your part. We will show you what happens and three easy steps to sort 

the objects. Important note: GOCAD Mining Suite is not backward compatible to 2009.4p1. Once a 

project has been saved in 14.1, it cannot be opened in 2009.4p1. We recommend that you create a 

2009.4p1 backup before conversion. 

When the above project is opened in 14.1, after clicking on the Show/Hide Grouping button  and 

expanding the objects, it looks like this: 
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Some objects have been automatically assigned to Classifications based on their type. They are found in 

the Objects display under various Classifications depending on their object type and what commands 

were previously executed on them in 2009.4p1. Everything else has been stored in the Unassigned 

Objects display.  

For those objects that are automatically assigned to the new Classifications and Features upon opening 

an existing 2009.4p1 project, here is how they are assigned: 

• Voxets are assigned to the 3D Survey Classification  

• Well Markers are assigned to the Horizon Classification under a Feature name that is the same 

as the Well Marker name. 

• Sgrids are assigned to the Reservoir Models Classification 

• Groups and Favourites are now Lists. 

Object reassignment 

There are three methods that can be used to reassign your objects: a simple drag and drop, assigning a 

new Geological Feature, or cleaning up the assigned Objects display. After opening your project for the 

first time, chose one, or more, of the following methods to reassign your objects. 

Method 1: Drag and drop 

This is to add an unassigned object to an already existing Feature. In this example the various curves and 

surfaces that relate to the Horizons are prime candidates for this method. 

1- Left click on the unassigned object to drag it to the correct feature. 

2- Select Assign Object to Feature and continue for all objects. 
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When a Feature is updated it becomes bold, telling you that it has been updated. The colour that the 

object is displayed in the 3D Viewer is governed by that defined for the Feature. This can be overridden. 

Method 2: Assigning geological classification and feature 

This is for dealing with objects such as Voxets that have been assigned automatically to the 3D Survey 

Classification when you want them in fact assigned to Classifications such as Lithology Block Model, 

Ground Gravity, Topographic Information, etc. 

1- Right click on the object to open the contextual menu. 

2- Select Assign Geologic Feature. 

3- If you want to change the suggested Feature name, you can do it here and then select the 

Geologic type. The “Geologic type” is your Classification. 

 

This method also works for objects that are in the Unassigned Objects display. 

Tip 

• If you know the first letter of the Geologic type, you can press that letter until you cycle through to 

it. A list of the most common Classifications is available in the release notes. 

• If there are other objects to be added to a Feature, then use the drag and drop method above. 

Method 3: Cleaning-up the assigned Objects display 

When a project has evolved through different versions of GOCAD Mining Suite it can carry artifacts. In 

certain instances, it can impact the automatic assignment of objects to a Classification, making them 
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difficult to find. This method will move all PointsSets, Curves and Surfaces to the Unassigned Objects 

display. 

1- Go to the PointsSet, Curve or Surface Menu and under Tools, select Remove (Unassign) 
Geologic Feature. 

2- Select all the available objects. 

3- Click OK. 

 

At this point you will likely have some empty features that contain no objects, we recommend deleting 

these: 

4- Right click on any empty feature 

5- Select Delete Feature 
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As done for the Remove Object from Feature dialog box, select all available features and click OK. Only 

empty features will be removed from the Objects display with this step, leaving features that still contain 

data. 

After reclassifying your objects, the Display Elements may look similar to this: 

 

Additional tips 

• If you want to change the name of a feature or object, right click on it and select “Rename…” (or 

left click then F2). 

• A Feature cannot be deleted if it contains objects, be sure to reclassify them first (right click > 

Assign to Geologic Feature). 
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Licence Manager  

The interface was redesigned to follow the flow process of adding or updating the licence file/server.  

 

Supported Operating Systems 

GOCAD Mining Suite 14.1 is supported on: 

• Microsoft Windows 7 Enterprise edition (64 bit) 

• Microsoft Windows Vista Business, Enterprise, or Ultimate edition (64 bit) 

 

IMPORTANT – A valid licence is required to run this new version. 32 bit operating systems are no longer 

supported. 

 

For more information about system requirements and complete installation information, please refer to the 

Installation Instructions that were provided to you with the updated licence file or contact 

licensing@mirageoscience.com. 

mailto:licensing@mirageoscience.com
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Contact information 

 
For general information or queries, contact us at info@mirageoscience.com. 

For software purchase inquiries you may contact a representative at sales@mirageoscience.com.  

For installation support our licensing team is there to help licensing@mirageoscience.com. 

For technical support regarding usage of our software products, please send a note to our support team 
at support@mirageoscience.com. 

 

Canada 

Montreal (head office) 

Mira Geoscience Ltd. 
#309 – 310 Victoria Avenue 
Westmount, QC, H3Z 2M9 

Tel: +1 (514) 489-1890 
Fax: +1 (514) 489-5536 

 

Vancouver 

Mira Geoscience Ltd. 
#512B - 409 Granville Street 
Vancouver, BC, V6C 1T2 

Tel: +1 (778) 329-0430 
 

 

 
Australia 

Brisbane 
 
Mira Geoscience Asia Pacific Pty Ltd 
Level 1, 39 Sherwood Rd 
Toowong, Brisbane 
Queensland 4066 
 
Tel: + 61 7 3720 8321 
Fax: + 61 7 3870 2389 

 

Perth 
 
Mira Geoscience Asia Pacific Pty Ltd 
45 Ventnor Avenue 
West Perth 
WA 6005 
 
Tel: + 61 8 9429 8838 
Fax: + 61 8 9429 8800 

 

mailto:info@mirageoscience.com
mailto:sales@mirageoscience.com
mailto:licensing@mirageoscience.com
mailto:support@mirageoscience.com
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